Electronic Manuscript Rapid Reports Template
Word 2010 for Windows
Instructions for using the template
Download the appropriate version of the template and save it to your word-processing package.
Check the Biochemistry Information for Authors page before using the template to verify that
you are using the most recent version. This document should be saved in the Templates folder
with a “.dotx” extension and will appear on the General tab in the New dialog box.
There are a number of paragraph styles available for use with this template to identify the
different parts of your manuscript, i.e., Title, Author Names, Abstract, etc. In Microsoft Word,
the name of the current paragraph style is displayed on the formatting toolbar in a box on the top
left side of your screen. Use the styles provided in the template for each corresponding section of
your paper. By using the paragraph styles you identify the components of your paper, alerting the
editorial office to how the different parts of the paper should be formatted. Each paragraph must
have a Word Style defining it. Do NOT modify any of the specifications of the template (text
size, font, line spacing, line height, margins, etc.) to make your Rapid Reports fit the three-page
limit. Your paper will be formatted as part of the journal production process, and the appearance
of the published paper may vary from what is in the template, i.e., lines above and below figures,
charts, and schemes. Authors should refer to the User's Guide for their individual word processor
or graphics package for answers to questions directly related to those programs.

Downloading the template
1. Select the version of the Biochemistry Rapid Reports template from the Biochemistry
templates page that corresponds to the version of word-processing software you will be
using to prepare your manuscript. The template will be downloaded as a "template" file
rather than as a "document" file. In Word, it will have the file extension ".dotx" instead of
".docx".
2. After saving the file open Word, click the File tab, then click New.
3. Select New from existing, select the Biochemistry Rapid Reports template, then click
Create New, this will open a copy of the file into Word.
4. Next click the File tab, then click Save As.
5. In the Save As dialog box do one of the following
a. On a computer that is running Windows 7, scroll to the top of the folder list, and
under Microsoft Word click Templates.
b. On a computer that is running Windows Vista, under Favorite Links, click
Templates.
c. On a computer that is running Windows XP, under Save in, click Trusted
Templates.

6. Give the Biochemistry Rapid Reports template a file name, select Word Template in the
Save as type list and then click Save and close the template.
This document is now saved in the Templates folder with a “.dotx” extension and will appear
on the File tab in the New dialog box under My Templates.

Working with the template
There are several ways to use this template to generate your final manuscript to be submitted for
publication: (a) Use the template to create a manuscript, (B) copy and paste the working
document into the template, and (C) attach the template to a working document. Detailed
instructions are given below for each of these methods as well as general instructions for all
methods. Be sure to always check the Biochemistry Information for Authors page to ensure that
you are using the most recent version of the template.

A. Using the template to create a manuscript
1. Create a document from the template by choosing File, New. You should see the
Biochemistry Rapid Reports template file available for use in the My Templates category.
NOTE: If it does not appear, open the file from the location where you saved it and resave
it as a Document Template using the same file name. This should make it so that it does
appear on the My Templates tab in the New dialog box.
2. Select the Biochemistry Rapid Reports Template and make sure the option Create New:
Document (not Template) is selected. Click OK. You will see a file containing sample
text sections with tips for using the template and guidelines for what each section contains.
This text is formatted with the paragraph style appropriate for the section. In addition, a
popup Styles toolbar should appear on your screen listing the Word Styles available. This
toolbar can be closed and reopened for later use when needed (Alt+Ctrl+Shift+S). When
you use the template to create a document, the new document will be a copy of the
template containing the information you input and the original template file will remain
unchanged.
3. Select (highlight) the text of the template that you want to replace and begin typing your
manuscript (i.e., select the Title section for typing in your title), ensuring that you have
selected text from the appropriate section (i.e., the Author Names section for typing in
your author names).

B. Copying and pasting a document into the template
If you have prepared your document in a file not using the template, you can copy text from the
working document and paste it into the template file.

1. Create a document from the template by choosing File, New. You should see the
Biochemistry Rapid Reports template file available for use in the My Templates
category. NOTE: If it does not appear, open the file from the location where you saved it
and resave it as a Document Template using the same file name. This should make it so
that it does appear on the My Templates tab in the New dialog box.
2. Select the Biochemistry Rapid Reports Template and make sure the option Create New:
Document (not Template) is selected. Click OK. You will see a file containing sample
text sections with tips for using the template and guidelines for what each section
contains. This text is formatted with the paragraph style appropriate for the section. In
addition, a popup Styles toolbar should appear on your screen listing the Word Styles
available. This toolbar can be closed and reopened for later use when needed
(Alt+Ctrl+Shift+S). When you use the template to create a document, the new document
will be a copy of the template containing the information you input and the original
template file will remain unchanged.
3. Open your existing manuscript file.
4. Copy and paste text from the working document into the appropriate sections of the
template. It is easiest to copy the entire document and then assign a Word Style to each
paragraph after pasting. NOTE: if you choose to copy and paste sections from your
original document rather than the entire document, be sure to include just the text (not
the paragraph symbol) and paste it into the template. If the paragraph symbol is copied,
the style of your original document overrides the template style. To change the style back
to the template style, click anywhere in the pasted-in text and select the proper Word
Style from the Word Styles list.
If copying the entire document and then assigning a Word Style to each paragraph after pasting,
you will need to change the page setup in the main text section of the paper. After the author
address, change the page format for the rest of the manuscript to two-column text. Place the
cursor at the beginning of the first paragraph of the main text section of the paper. Insert a
continuous section break (Page Layout, Breaks, select Continuous from Breaks drop-down).
Click on the Columns drop-down from the Page Setup section in Page Layout and select More
Columns. Make the following changes in this window: Number of Columns 2, Width 3.33”,
Spacing 0.33”. Click OK. Assign the appropriate Word Style to the remainder of the paper.

C. Attaching the template to a document
If you have prepared your document in a file not using the template, you can attach the template
to your working document and apply the Word Style tags. If attaching the template to your
document, you will need to print a copy of the template first so that you can identify which Word
Style should be applied to the different sections of your manuscript (File, New, and select the
Biochemistry Rapid Reports template).
1. Open your manuscript file.
2. Select File on the toolbar and then Options. NOTE: There are several ways to import
templates/styles into working documents within Word. See the "templates" section of
Microsoft Word Help for further instructions.

3. Choose Add-Ins in the Word Options dialog box.
4. Select Templates from the Manage drop-down list, then click Go.
5. Click the Add button and choose the appropriate ACS template, then select Ok.
6. Select Ok again. This will return you to the working document.
7. A popup Styles toolbar has been generated that will display the different Word Styles for
easier use. If you do not see this toolbar, do (Alt+Ctrl+Shift+S), and it should appear.
You can close this at any time and reopen it when needed.
8. Change the page layout. Under Page Layout, select the Margins drop down list. Select
Custom Margins tab, type in the following dimensions to ensure your manuscript is the
proper size: Top 0.5”, Bottom 0.66”, Left 0.76”, Right 0.76”, Gutter 0”. On the Paper
Size drop-down select More Paper Sizes, in Paper tab set size Letter, Width 8.5”, Height
11”, then on the Layout tab set the Header 0”, and Footer 0”.
9. Place the cursor in the title section of your document. Using the Word Style menu on the
formatting toolbar, select Word Style “BA_Title”. This will apply the Word Style to the
title. Do this for the author names and addresses using the appropriate style.
10. Change the page format for the rest of the manuscript to two-column text. Place the
cursor at the beginning of the first paragraph of the main text section of the paper. Insert a
continuous section break (Page Layout, Breaks, select Continuous from Breaks dropdown). Click on the Columns drop-down from the Page Setup section in Page Layout
and select More Columns. Make the following changes in this window: Number of
Columns 2, Width 3.33”, Spacing 0.33”. Click OK. Assign the appropriate Word Style
to the remainder of the paper.
11. Insert figures, schemes, charts, and tables by creating a blank line where you want each to
appear, making sure the Word Style is “Normal” with an automatic height adjustment.

General instructions for all methods
1. Submit a graphic entry for the Table of Contents (TOC) that, in conjunction with the
manuscript title, should give the reader a representative idea of one of the following: a key
structure, reaction, equation, concept, or theorem, etc., or an ingenious representation,
thereof, that is discussed in the manuscript. The TOC graphic should be no wider than 7
cm. (2.8 in.) and no taller than 3.5 cm. (1.375 in.). Space for this is provided on the third
page of the template.
2. Submit a concise, self-contained, one-paragraph abstract for Web publication (between 80
and 200 words). Space for this is provided on the third page of the template.
3. Use carriage returns to end headings and paragraphs only. Do not use carriage returns to
break lines. Use a spell checker to detect any typos and eliminate any spaces before
punctuation.

4. Pay particular attention to the format of the references to ensure that they comply with the
style in use for the journal. The responsibility for accuracy of the references lies with the
author.
5. Present tabular material by using the table-formatting feature in your word-processing
package. Enter each data element in its own cell.
6. Ensure all characters are correctly represented throughout the manuscript: for example, 1
(one) and l (ell), 0 (zero) and O (oh). Use symbol font for all Greek letters and math
symbols. Use only characters in your file that came with the character sets in your word
processor.

Working with graphics in the template
To insert a graphic within the text or as a figure, chart, scheme, or table, create a new line and
insert the graphic where desired. Tip: inserting artwork into your Rapid Reports may be
simplified by formatting the paper as one-column (Page Layout, Columns, Number of
Columns 1) rather than two-column text, inserting artwork, and then reformatting to two-column
text (Page Layout, Columns, Number of Columns 2, Width 3.33”, Spacing 0.33”).
If your graphic is not visible, ensure that the Word Style is “Normal” with an automatic height
adjustment (from the Page Layout menu, choose Paragraph; under Line Spacing, choose
Single) and not Word Style “TA_Main_Text”, “VA_Figure_Caption”, “VB_Chart_Title”,
“VC_Scheme_Title”, “VD_Table_Title”, or “TC_Table_Body”.
Paste the graphics at the size they will be printed in the journal. NOTE: If your artwork is larger
than the width of a column, Word may reduce the size so that it fits within the column. This will
alter the resolution of your graphic, making it unacceptable for publication. You must resize the
artwork in your graphics package and re-paste it into the file. Do NOT resize or add labels to
the artwork from within Word: maximum width for single-column artwork, 3.3 in. (8.5 cm);
maximum width for double-column artwork, 7 in. (17.8 cm).
If your artwork does not appear where you placed it and is floating over text, select the piece of
artwork by clicking on it. Under Picture Tools, select Picture or Object and then select the
Position tab. Make sure the Float over text box is NOT selected. If it is, deselect it and select
OK. This should make your artwork appear where you originally placed it.

ChemDraw directions
Follow the drawing settings in the ACS-1996 Style Sheet for preparing your artwork. It is best to
copy the actual artwork and paste it into Word rather than saving it as a file and pasting the file
in. In addition, for versions later than 2.1.3, in the ChemDraw Preferences (File, Preferences),
ensure that the Optimize for High-Resolution non-Postscript Printing, Include ChemDraw
LaserPrep, and Include PostScript Preferences are ON. Use of ChemDraw versions 2.1.3 or
below and any version of ChemDraw Plus is not encouraged, as they are not compatible with the

process that generates the PDF file for your manuscript. If it is absolutely necessary to use one of
these older versions of ChemDraw, deselect Include PostScript Atom Labels (File,
Preferences). This will prevent incompatible PostScript information from being embedded in the
structure. NOTE: this may result in structures of inferior quality; thus, the use of an updated
version of ChemDraw is strongly encouraged.

Corresponding author footnote help
Insert footnotes for author affiliations before the references at the end of the paper, giving them a
symbol rather than a number. Insert the symbol after the author name to which this pertains.

Saving your manuscript in the template
When you are finished and are ready to save your document, if necessary, delete all sections
from the template that are not needed, including the instructions. Assign the file a name that will
identify your manuscript, one that is different than that of the template. Save the file with the
graphics in place. In Microsoft Word, click Save As (File menu) and save it as a “document” file
(.docx).
NOTE: To use the template with Microsoft Word 2007 (PC version) and Microsoft Word 2008
(Macintosh version), Save your Word files in the compatibility format (Word 97-2003) using the
“Save As” option.

Checking your manuscript for completeness
Proof a printout of the manuscript (from a 600 dpi or higher laser printer) to ensure that all parts
of the manuscript are present and clearly legible.

Submitting your manuscript
Follow the Information for Authors link from the Biochemistry home page for the latest
instructions on how to proceed with the submission of your manuscript. If submitting
electronically, your manuscript will be converted to a PDF file. This file is used strictly for peer
review. The length of the file when converted to the PDF version may change. If your
manuscript fits within two pages in the word-processing template and exceeds this length only
after conversion to PDF, there is no need to readjust the length of your file in Word to make it fit
the two-page limit. Additional formatting changes may occur. In addition, the appearance of
footnote numbers does not need to be changed to match the journal style.

Additional resources
Authors should refer to the User's Guides for their individual word processor and graphics
programs for more specific instructions on how to use these packages. In addition, most software
manufacturers maintain on-line help resources. Two good sources of additional information are
the Microsoft Web site (http://www.microsoft.com/) and the ChemDraw Web site
(http://www.cambridgesoft.com/software/ChemDraw/).
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